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Content of package 

• WidePIX / WidePIX L Medipix3 device 

• +24 V DC adapter 

• Quick couplings for water cooling 

• USB memory stick with control software Pixet 

Start guide 
1. Connect the device to the water-cooling system. Thermal stabilization to 20-25°C is strongly 

recommended. 

2. Plug in the power adapter. 

3. Connect the device to your computer via USB/UTP cables. First use of ethernet version of the 
device requires the reset of IP address (see the IP address reset tutorial; page 4). 

4. Connect the attached USB memory stick to the computer. 

5. Install the device drivers: 

◦ Microsoft Windows: run drivers/setup.exe and follow the instructions. 

◦ macOS: run drivers/D2xxHelper_v2.0.0.pkg. 

◦ Linux: installation of any special drivers is not required. 

6. Install the Pixet application: 

◦ Pixet for Windows is distributed as a single executable file for automatic installation. Run 
setup.exe and follow the instructions it the setup wizard. 

◦ Pixet for macOS system is distributed as a standard dmg file (disk image file). After mounting 
the pixet.dmg file a window with disk content will open. To install, move the Pixet folder to the 
Application folder. 

◦ Pixet for Linux system is distributed as a single tar file. To install, untar the file at a required 
location. The application is launched by executing the pixet.sh script. 

7. Run Pixet application. An icon with ID of your device must appear in the left panel. 

8. Default configuration of the connected device is loaded automatically. Configuration file contains 
default settings of the detector including calibration of energy thresholds to keV. Settings of 
thresholds in keV and bias voltage are shown in the Detector Settings panel when the 
configuration is properly loaded. The device is now ready for use. However, it is advisable not 
to start any measurements until the thermal equilibrium is established (~ 20 minutes). 

9. Last detector settings with all your modifications are stored locally on your computer when Pixet 
is closed. The settings will be loaded again when starting Pixet with the same device next time. 
The defaults can be restored at any time by loading the default configuration: Click File – Load 
Config in menu bar and choose the configuration file using system dialog window. It is located in 
the Pixet/configs folder and has .xml extension. 
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WidePIX L – IP address reset 
1. If not connected, connect power supply 

2. If connected, disconnect all UTP cables 

3. Press and hold “IP RESET” button for 10 s 

4. Connect UTP cable 

 Connect one end of UTP cable to the one of the Ethernet ports on the detector 

 Connect the second end of the UTP cable to the network card of the computer 

5. Change network settings 

 Start -> Windows settings -> Network & Internet -> Ethernet -> Change adapter options 

 Right-click on the Ethernet Icon and select Properties 

 Select Internet Protocol Version 4 (TCP/IPv4), then click on Properies button 

 

 Fill the table similarly as shown in the picture below 
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6. Change detector’s IP setting 

 Open web browser any type in 192.168.1.100 

 

 Network configuration server will appear 

 Configure desired network parameters and then click to Update 

 Then type in Web browser new IP address, if the process was successful Advacam 
Configuration Server will appear 

7. Go to 4. And repeat process with another Ethernet port 

 

WidePIX L – LAN requirements 
 

 Direct cable from Widepix to network card or via gigabit switch with no load on other ports. 

 To take full advantage of the speed of the dual-port widepix, use two direct cables to two 
network cards in computer. 

 If there is a slower or more complex network between the Widepix and the computer, the 
framerate may be limited, bad frames can occur, or some measurements may fail. 
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Understanding the Medipix3 chip operation 
Comparison of Medipix and Timepix chips 

• Timepix-based detectors allow both the photon counting and spectroscopic “time-
over-threshold” measurement. Medipix-based detectors operate only in the photon 
counting mode. However, the radiation spectra can be measured using a threshold 
scan. 

• Timepix-based detectors have single energy threshold. All energies below the set 
value  are cut off. Devices are set to a minimal threshold above noise by default. This 
is typically 5 keV. The threshold can be adjusted by user in the counting mode. 

• Medipix3 detectors have one or more adjustable energy thresholds. The number of 
thresholds varies according to the sensor pixel pitch and the mode of operation. The 
logic is the same as for Timepix-based detectors; all available thresholds cut off lower 
radiation energies. Minimum threshold is typically higher compared to Timepix-based 
devices and depends on additional settings. 

• Unlike the Timepix-based detectors, the Medipix3 offers several operation modes for 
the counting measurement. The list of modes is described in the following section. 

 
Overview of Medipix3 read-out chip operation 

Each pixel of the Medipix3 (MPX3) chip has two thresholds and two 12-bit counters, which can be 
alternatively merged to one 24-bit counter, providing enhanced dynamic range. 

In principle, two main modes of operation are available:   

1. Single Pixel Mode (SPM): every pixel works independently of its neighbours, analogous to 
Timepix-based devices. 

2. Charge Summing Mode (CSM): two thresholds are used for the energy discrimination. The 
algorithm is as follows: the detected quantum of radiation generates an electric charge in the 
sensor. The charge is typically collected to two or more pixels and creates an electric signal in 
each pixel. The signal is compared to the first threshold in every pixel. Signals below the threshold 
are cut off (similar to the SPM). The signal/charge of 4 neighbouring pixels is reconstructed 
(summed) and assigned to the pixel with the largest charge deposition. The result is then 
compared to the second threshold, signals below the threshold are omitted. 

The CSM suppresses the effect of charge sharing and the images are sharper in comparison to the SPM. 

Both modes can be moreover operated in several ranges which define the minimal and maximal 
achievable threshold. Selection of the range affects also further properties, such as the energy resolution 
and stability (noise) of the detector. The range setting can be found in literature under the term “gain 
mode”. 
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Settings of WidePIX MPX3 device (55 μm pixel pitch) 
Setting the operation mode and counter depth 

Mode of operation can be selected via drop-down list in the Detector Settings panel:    

• SPM 1 CH (Single Pixel Mode – one channel). One counter is in use. One energy threshold 
(energy channel) is available. Measurement output: one 12-bit or 24-bit image representing the 
number of events per pixel. 

• SPM 2 CH (Single Pixel Mode – two channels). Two counters are in use. Two energy thresholds 
(energy channels) are available. Measurement output: two 12-bit images representing the 
number of events per pixel. 

• CSM (Charge  Summing  Mode). Two energy thresholds are in use. Measurement output: one 
12-bit or 24-bit image representing the number of events per pixel. 

After changing the operation mode, values of the energy thresholds may change according to the 
respective energy calibration. 

 

 

Counter depth is set to 12 bits by default. Check the checkbox in the Detector Settings panel for the 24-
bit depth. 

 

 

Setting the range - advanced 

Click on the More Detector Settings button in the Detector Settings panel. New window will appear. Select 
the range in the drop-down list within the Settings section of the first Detector tab: 

• Broad – the largest threshold range. 

• Narrow – better energy resolution at lower energies. 

• Super Narrow – very limited threshold range, the best energy resolution at lower energies, better 
signal-to-noise ratio. 

Note: Super Narrow range is not available with silicon detectors. 
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Click OK  to confirm the changes. 

Note: the Custom Settings section is intended for expert users only. Any modification of Custom 
Settings section may lead to unpredictable behavior of the device! 

 

 

Useful tips and how-tos 

Pixet Pro is being developed in Advacam s.r.o. as desktop application for expert users. It implements full 
control of the Timepix- / Medipix-based detectors and it is used within manufacturing processes (testing, 
calibration, …) as well as during the preceding development phase of the devices. Since the application 
is very powerful, inexperienced user could set the device to non-functioning state. Recovery from such 
case is loading the factory settings shipped with the detector. 

Here are several tips for more effective and comfortable use: 

• Composition of panels on the right side of the Pixet window can be configured in Panels in menu 
bar. 

• Orientation of the image (rotation, mirroring) can be customized in View drop-down list in menu 
bar. 

 

 
• To keep the aspect ratio of the image click on View – Ensure Aspect Ratio in menu bar. 

! 
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• Default colormap is gray. Colormap can  be selected via drop-down list under the multicolored 
icon located in main toolbar. 

 

 
 

• Image Properties panel allows to adjust brightness and contrast of the displayed images by 
setting the range to be displayed. Auto range option provides automatic adjustment. 

• Advanced Image Properties panel allows to set gamma correction for better visibility of features 
within measured sample. 

• Pixet allows opening and showing previously saved images by drag and drop into image area of 
the Pixet window. When multiple images are drag and dropped, one can browse them using blue 
arrows in the main toolbar. 

 
 
 

 
 
 
 
 

• Images can be zoomed by holding the left mouse button in the frame, dragging the mouse to 
create a selection rectangle and releasing the mouse button. To restore the original frame size, 
double click on the image. 

• Application output including error messages are shown in Messages panel. 
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• In case of hardware disconnection, the device can be reconnected by clicking File – Reconnect 

in menu bar without restarting Pixet application. 
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WidePIX L Sync guide 
 

Master/Slave decision: 

See readout parameters: Device with TriggerMaster = yes is master.  

Note: The bias source is connected to the master segment. 

 

Master setup 

1. Set TriggerStg = 0 in readout parameters 

2. Set TriggerWaitForReady = yes in readout parameters 

3. Set TriggerOutLevel = 1 in readout params 

4. Set synchronization Started by HW Trigger in Measurement Settings. 

 

Slave setup 

1. Set TriggerStg = 2 in readout parameters 

2. Set TriggerWaitForReady = yes in readout parameters 

3. Set synchronization Started by HW Trigger in Measurement Settings at General panel. 

 

The acquisition 

• Set acquisition parameters for both Master and Slave device. 

• Run acquisition for Slave device - the device will wait for the master's trigger. 

• Run acquisition for Master device - both devices start the acquisition. 

 

TriggerStg and TriggerOutLevel setup 

 

The TriggerStg and TriggerOutLevel are linked in the following way: 

Function 
Master 

TriggerStg 
Master TriggerOutLevel 

Slave 
TriggerStg 

Slave TriggerOutLevel 

Sync 1:1 0 0 3 X 

Alternating sync 0 0 2 X 

Alternating sync 0 1 3 X 

Sync 1:1 0 1 2 X 
 

X - the value effect the measurement 
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Practical examples of measurements 

1. Measurement in SPM using one threshold 
Setting of the detector on Detector Settings panel 

• Set the device to SPM 1 CH operation mode as described above. 

• Switch on / off the 24-bit counter depth as described above (optional). 

• Set first threshold THL 0 [keV] to desired value. Second threshold THL 1 [keV] is not in use for 
this operation mode. 

 

Controlling the measurement parameters via Measurement panel 

• Select type of measurement in Type drop-down list. There are three options: 

◦ For single acquisition select Frames and set parameter Count to 1. 

◦ Integral – several acquisitions are added to one frame. Number of acquisitions to be added 
is defined by parameter Count. 

◦ Test Pulses – for service use only. 

• Set the exposure time of individual frame acquisitions in seconds using Time [s] text box. 

• Checking the Repeat checkbox and setting the number of repetitions using the text box 
underneath will cause repeating the defined measurement several times. Setting the number of 
repetitions to zero value means “repeat forever”. If the Repeat checkbox is unchecked, the 
number of repetitions is not in use. 

 

Note: In case of combining Repeat and Frames, it is advisable to set the Count parameter to value greater 
than 1, especially for acquisition times shorter than 1 s. This prevents from unwanted increase of 
measurement dead time. 

 

Starting the measurement 

Start / stop the measurement using Start / Stop button on the Measurement panel. Progress of the 
measurement is shown in the status bar at the bottom of the window. 

Once the measurement is finished, the measured frame is shown in the image preview area of the Pixet 
window. 

 

Automatic saving of measured data 

Check File output in Measurement panel for automatic saving. Then click on the button with three dots. 
A system dialog window will appear to Select the target destination and filename. Confirm it by clicking 
the Save button. Measured data are saved automatically during the measurement. A warning dialog will 
appear if the file name and destination is used for another measurement. 
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Two files are saved by default to each frame: 

• data file (.txt) 

• description file (.dsc) which contains information about the device, used configuration, 
measurement settings, etc. 

 

Manual saving of measured data 

Click on Save Measured Data option in View drop-down list in menu bar. A system dialog window will 
appear. Select the target destination and filename and confirm by clicking the Save button. All frames 
within the sequence defined by the Count parameter are saved. 

Save Current Frame option in View drop-down list in menu bar will save the last frame only. Option Save 
All Frames is similar to the Save Measured Data in this case. 

 

 

 

2. Measurement in SPM using two thresholds 
Setup of the detector in Detector Settings panel 

• Set the device to SPM 2 CH operation mode as described above. 

• 24-bit counter depth is not available. 

• Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold should be 
higher than the first threshold. 

 

 

Controlling the measurement parameters via Measurement panel 

See example 1. 
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Starting the measurement 

See example 1. 

Once the measurement is finished, the measured frames are shown in the image preview area of the 
Pixet window. Use buttons at the image area bottom to switch between the energy channels. 

 

 

 

 

 

Automatic saving of measured data 

See example 1. 

Six files are saved by default: 

• data file (.txt) for first channel with ending “_THL0” 

• description file (.dsc) for first channel with ending “_THL0” 

• data file (.txt) for second channel with ending “_THL1” 

• description file (.dsc) for second channel with ending “_THL1” 

• data file (.txt) combining both channels – for service use. 

• description file (.dsc) combining both channels – for service use.  

 

How to save measured data manually 

Click Save Measured Data option in View drop-down list in the menu bar. A system dialog window will 
appear. Select the target destination and filename and confirm it by clicking the Save button. All frames 
within the sequence defined by the Count parameter are saved for both channels. 

Click Save All Frames to save the entire frame sequence of the selected channel only. 

Click Save Current Frame option in View drop-down list in menu bar to save the last frame of the selected 
channel only. 
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3. Measurement in CSM 
Setting of the detector on Detector Settings panel 

• Set the device to CSM operation mode as described above. 

• Switch on / off the 24-bit counter depth as described above (optional). 

• Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold should be 
higher than first threshold. 

 

 

Controlling the measurement parameters via Measurement panel 

See example 1. 

 

Starting the measurement 

See example 1. 

 

Automatic saving of measured data 

See example 1. 

 

How to save measured data manually 

See example 1. 

 

4. Measurement in Time Delay Integration regime 
The time delay integration (TDI) is implemented for WidePIX 1x5, WidePIX L 1xN (N = 5, 10, 15, …) 
devices. TDI can be used for continuous scanning where for example samples move on a conveyor belt 
along the detector. 

 

Setting up the Time Delay Integration regime 

To switch on / off this functionality click on More Measurement Settings button in the Measurement panel. 
New window will appear. Then check / uncheck Time Delayed Integration (TDI) checkbox in the Advanced 
Measurement Settings section on the first tab 
General. Confirm the change by clicking OK. 
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All operation modes, bit depths and ranges of static measurement (as described in previoew section) are 
implemented also in TDI. 

 

Alignment of the experiment 

Sample to be measured has to move along the detector. Movement of the sample with respect to the 
WidePIX device must be in the sense from the top to the image bottom (i.e. towards the device readout 
peripheries; by default the image in Pixet is oriented with peripheries at the bottom). 

 

Basic settings 

Set the operation mode, counter depth and energy threshold(s) as desired. Switch on the TDI regime as 
described above. 

 

Measurement panel 

• Set the Type of measurement to Frames. 

• Set number of frames into Count. 

• Enable repeating and set number of repeats. 

• Set acquisition time Time [s] corresponding to the movement of the sample by chip size (dead 
time for the chip read-out should be included). The chip size is 256x0.055=14.08 mm. Hence, the 
exposure time corresponds to the speed the sample moves along this distance. To achieve a 
perfect synchronization the time can be optimized by evaluation of the object sharpness. 

 

Automatic saving of measured data 

See example 1. 

 

How to save measured data manually 

See example 1. 
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Advanced control using Python Scripting plugin 
Python Scripting plugin allows the user to perform complex measurements controlling the detectors 
automatically via Python commands and scripts. The Python Scripting embeds a full python 2.7 
interpreter including the standard python libraries. All standard functionality of python is threfore 
accessible. Please refer to www.python.org or www.learnpython.org for more information about Python 
programming language. 

Click on the icon on the right edge of the main toolbar to start the Python Scripting plugin. Choose Python 
Scripting from the list. A new window with simple editor will open. The bottom part of the plugin window 
contains a python console, where python commands can be run one by one with immediate output. The 
console also contains the output of executed python script. 

 

 
 
 

 
The Pixet API (Application Programming Interface) is accessible in the scripts via a pixet variable. This 
variable represents the IPixet object that provides all the necessary methods to get information about all 
connected devices, log messages to log file, access the Pixet menu, etc. A list of all available objects, 
methods and constants of the Pixet API can be displayed by clicking Help – Function List… in the main 
menu of the Python Scripting window. 

 

5. Sample script #1 
Detector settings (operation mode, counter depth, range, threshold), simple acquisition 
 

# get list of all connected Medipix3 devices 
devices = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3) 
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# get first device from list 
dev = devices[0] # returns IDevMpx3 object 
 
# set operation mode 
dev.setOperationMode(pixet.PX_MPX3_OPM_SPM_1CH) 
# SPM 1 CH:  pixet.PX_MPX3_OPM_SPM_1CH (0) 
# SPM 2 CH:  pixet.PX_MPX3_OPM_SPM_2CH (1) 
# CSM:       pixet.PX_MPX3_OPM_CSM (2) 
 
# get operation mode 
print('Operation mode: ' + str(dev.operationMode())) 
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# set counter depth 
dev.setCounterDepth(pixet.PX_MPX3_CNTD_24B) 
# 12 bits:  pixet.PX_MPX3_CNTD_12B (2) 
# 24 bits:  pixet.PX_MPX3_CNTD_24B (3) 
 
# get counter depth 
print('Counter depth: ' + str(dev.counterDepth())) 
 
# set range 
dev.setGain(pixet.PX_MPX3_GAIN_SUPERHIGH) 
# Super Narrow: pixet.PX_MPX3_GAIN_SUPERHIGH (0) 
# Narrow:       pixet.PX_MPX3_GAIN_HIGH (1) 
# Broad:        pixet.PX_MPX3_GAIN_SUPERLOW (3) 
 
# set threshold 
th_index = pixet.PX_MPX3_TH0  # index of threshold to be changed 
# THL 0: pixet.PX_MPX3_TH0 (0) 
# THL 1: pixet.PX_MPX3_TH1 (1) 
chip = 4                      # chip index (chips are counted from 0!) 
# chip #1:   0 
# chip #5:   4 
# all chips: pixet.PX_CHIP_ALL (-1) 
th_energy = 30                # new value of threshold in keV 
dev.setThreshold(chip, th_index, th_energy, pixet.PX_THLFLG_ENERGY) 
 
# acquisition 
acqCount = 1        # number of acquisitions 
acqTime = 10        # time of acquisition in seconds 
dev.doSimpleAcquisition(acqCount, acqTime, pixet.PX_FTYPE_NONE, '') 
 
# get last acquired image 
frame = dev.lastAcqFrameRefInc() 
data = frame.data() 

 

6. Sample script #2 
Integral acquisition, saving the data 
 

# get first device from list of all connected Medipix3 devices 
dev = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)[0] 
 
# set operation mode 
dev.setOperationMode(pixet.PX_MPX3_OPM_SPM_2CH) 
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# set acquisition parameters 
acqCount = 10           # number of acquisitions for integral measurement 
acqTime = 0.1           # time of one acquisition 
fileName = './test/image.txt' 
 
# integral acquisition, saving 
dev.doSimpleIntegralAcquisition(acqCount, acqTime, pixet.PX_FTYPE_AUTODETECT, fileName) # data are automatically 
saved 

 

7. Sample script #3 
Threshold scan 
 

# get first device from list of all connected Medipix3 devices 
dev = pixet.devicesByType(pixet.PX_DEVTYPE_MPX3)[0] 
 
# set operation mode 
dev.setOperationMode(pixet.PX_MPX3_OPM_CSM) 
 
# set acquisition parameters 
th = pixet.PX_MPX3_TH1  # index of threshold to be changed 
ths = range(10,45,5)    # thresholds in keV 
acqCounts = [1 for number in ths] 
acqTimes = [0.1 for number in ths] 
output = './test_'      # destination path 
 
# threshold scan 
for i in range(len(ths)):         
    print('TH: {}'.format(ths[i])) 
    dev.setThreshold(pixet.PX_CHIP_ALL, th, ths[i], pixet.PX_THLFLG_ENERGY) 
 
    fileName = output + str(ths[i]).zfill(3) + 'keV.txt' 
 
    dev.doSimpleIntegralAcquisition(acqCounts[i], acqTimes[i], pixet.PX_FTYPE_AUTODETECT, fileName) 


